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1 Service Contact Information 

U.S. Service Information 
For questions regarding service or technical information contact: 
1.866.MAG.SERV 
(1.866.624.7378) 
 
International Service: 
+1.262.783.3500 
 
Magnetek, Inc. 
N49 W13650 Campbell Drive 
Menomonee Falls, WI 53051 
 
Telephone:  +1.800.288.8178 
 
Website:  www.magnetekmobilehydraulic.com 
e-mail:   MHCustomerservice@magnetek.com 
 
Fax Numbers: 
Main:    +1.800.298.3503 
Sales:    +1.262.783.3510 
Service:   +1.262.783.3508 
 
Canada Service Information: 
4090B Sladeview Crescent 
Mississauga, Ontario 
L5L 5Y5 Canada 
Phone: +1.800.792.7253 
Fax: +1.905.828.5707 
+1.416.424.7617 (27/7 Service pager) 

EU Market Contact: 
Brian Preston 
Magnetek (UK) Ltd. 
Unit 3 Bedford Business Centre 
Mile Road 
Bedford, MK42 9TW UK 
Phone: +44.1234.349191 
Fax: +44.1234.268955 

 
©2014 MAGNETEK 
 
All rights reserved. This notice applies to all copyrighted materials included with this product, including, 
but not limited to, this manual and software embodied within the product. This manual is intended for the 
sole use of the person(s) to whom it was provided, and any unauthorized distribution of the manual or 
dispersal of its contents is strictly forbidden. This manual may not be reproduced in whole or in part by 
any means whatsoever without the expressed written permission of MAGNETEK. 
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2 Preface and Safety 

2.1 Product Safety Information 
Magnetek, Inc. (Magnetek) offers a broad range of radio remote control products, control products and 
adjustable frequency drives, industrial braking systems, and power delivery products for material handling 
applications. This manual has been prepared by Magnetek to provide information and recommendations 
for the installation, use, operation and service of Magnetek’s material handling products and systems 
(Magnetek Products). Anyone who uses, operates, maintains, services, installs or owns Magnetek 
Products should know, understand and follow the instructions and safety recommendations in this manual 
for Magnetek Products. 
 
The recommendations in this manual do not take precedence over any of the following requirements 
relating to cranes, hoists, lifting devices or other equipment which use or include Magnetek 
Products: 
 

 Instructions, manuals, and safety warnings of the manufacturers of the equipment where the 
Magnetek Products are used, 

 Plant safety rules and procedures of the employers and the owners of the facilities where the 
Magnetek Products are being used, 

 Regulations issued by the Occupational Health and Safety Administration (OSHA), 
 Applicable local, state, provincial, or federal codes, ordinances, standards and requirements, or 
 Safety standards and practices for the industries in which Magnetek Products are used. 

 
This manual does not include or address the specific instructions and safety warnings of these 
manufacturers or any of the other requirements listed above. It is the responsibility of the owners, users 
and operators of the Magnetek Products to know, understand and follow all of these requirements. It is 
the responsibility of the employer to make its employees aware of all of the above listed requirements and 
to make certain that all operators are properly trained.  
 
No one should use Magnetek Products prior to becoming familiar with and being trained in these 
requirements and the instructions and safety recommendations for this manual. 
 

2.2 Product Warranty Information 
Magnetek, hereafter referred to as Company, assumes no responsibility for improper programming or 
operation of a device (such as a drive or radio) by untrained personnel.  A device should only be 
programmed or operated by a trained technician who has read and understands the contents of the 
relevant manual(s).  Improper programming or operation of a device can lead to unexpected, undesirable, 
or unsafe operation or performance of the device.  This may result in damage to equipment or personal 
injury.  Company shall not be liable for economic loss, property damage, or other consequential damages 
or physical injury sustained by the purchaser or by any third party as a result of such programming or 
operation.  Company neither assumes nor authorizes any other person to assume for Company any other 
liability in connection with the sale or use of this product. 
 
For information on Magnetek’s product warranties by product type, please visit www.magnetek.com. 
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2.3 WARNING, CAUTION, and NOTE Statements 
Read and understand this manual before installing, operating, or servicing this product. Install the product 
according to this manual and local codes. 
 
The following conventions indicate safety messages in this manual. Failure to heed these messages 
could cause fatal injury or damage products and related equipment and systems. 
 

WARNING 
WARNING indicates a potentially hazardous situation which, if not avoided, could result in death or 
serious injury. 

 

CAUTION 
CAUTION indicates a potentially hazardous situation which, if not avoided, could result in minor or 
moderate injury. It may also be used to alert against unsafe practices. 

 
NOTE: A NOTE statement is used to declare installation, operation, programming, or maintenance 
information that is important, but not hazard-related. 
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3 Introduction 

3.1 Overview 
NOTE: Please refer to the specific product manuals for telePilot, telePendant and inteleSmart usage. 
 
The Radio Control Programmer (RCP) is a user-friendly, Windows® based, interactive radio control 
programmer software. It is designed for communication from your PC to Magnetek radio control products. 
 
The USB RCP Kit (Part# 178-01702-0200) contains the following components: 
 

1. USB drive containing RCP Software 

2. USB Cable 

3. Activation Code 

 

3.2 Supported Products 

3.2.1 Supported Transmitters 

 telePilot 

 telePendant 

 MBT 

 PGT 

 Mini PGT 

 Mini MBT 

 XLTX 

 MLTX2 

 Flex VUE™ 

 CHTX 
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3.2.2 Supported Receivers 

 inteleSmart 

 inteleSmart2 

 MHR 

 MHC 

 CAN-2 

 WIC-2402 

 

3.3 PC Requirements 
 Windows XP (Service Pack 3 or later) 

o PC with 800MHz processor or better with at least 256 MB of RAM and 100 MB of hard 
disk space.  

 Windows Vista Basic, Home Premium, Business, or Ultimate (Service Pack 2) 

o PC with 800MHz 32-bit (x86) or 64-bit (x64) processor or better with at least 512MB of 
RAM and 20 GB hard drive. 

 Windows 7 Home Premium, Professional, Enterprise, Ultimate  

o PC with 800MHz 32-bit (x86) or 64-bit (x64) processor or better with at least 512MB of 
RAM and 20 GB hard drive. 

 USB port, mouse (or other pointing device), and keyboard. 

 Internet Connection (for product activation only). 
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4 Installation 
Insert the USB flash drive containing RCP 2.x into a USB port on your PC. Navigate to the flash drive and 
locate the RCPSetup.msi file. Double clicking this file will start the install process. When the installation is 
complete, RCP will be installed on your PC. 
 

4.1 Run the RCP Software 

After installation of the RCP Software, double-click the RCP icon  found on the desktop to launch 
the program. This will prompt you to enter an activation key. If an activation key is not entered at this time, 
the software can only be used 10 times before locking the user out. Contact customer service or your 
sales representative for an activation key. 
 

 
 

4.2 Software Updates 
Additional features and bug fixes may be available from time to time. These may be downloaded from the 
Magnetek website. 
 

4.3 Software Removal 
To remove the RCP Software, open the control panel’s “Add/Remove Programs” dialog box (Windows 
XP) or “Programs & Features” dialog box (Windows 7), double-click the Radio Control Programmer entry 
and choose Remove All from the dialog box. 
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5 Getting Started 

5.1 Start Page 
After the software has been activated, upon starting the user will see the Start Page.  This is where new 
projects are created or existing projects are opened.  This page also contains information on how to 
contact Magnetek. 
 

5.1.1 Creating a New Project 

To create a new project, click on the “New Project…” button on the Start Page. 
 

 
 
After clicking this, a new dialog will pop up, prompting the user to choose the type of device they would 
like to add to the project.  This lists all of the devices supported by RCP.  Select the device type to add to 
the project. 

Click to start a New Project 
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After selecting the device type, the user then has the ability to give the device a name.  The device name 
is solely used within RCP to help denote different devices within a project.  Certain devices support the 
ability to receive the device data upon being added to the project.  If a device does not support this, then 
the option will be greyed out. 
 
A project can be created either with the device connected or without a device connected.  If a project is 
created with a device connected, then RCP will read all of the configuration information from the device 
when the project is created (if the Receive Device Data box is checked).  Having this box checked and 
the device connected is recommended as it gives the user a starting point with configuration.  If the user 
chooses not to receive the device data or there is no device connected, then the current device 
configuration is unknown by the program.  The user MUST be aware of this as certain device 
configuration parameters will be overwritten by the program defaults when the programming is “sent” to 
the device.  This could mean that parameters such as the access code and RF channel are changed and 
a transmitter and receiver originally intended to communicate with each other will no longer communicate. 
 

  CAUTION 

ALWAYS BE AWARE OF THE CONFIGURATION OF A DEVICE.  NOT HAVING THE LATEST CONFIGURATION 
HAS THE POTENTIAL TO PREVENT DEVICES INTENDED TO COMMUNICATE TOGETHER FROM BEING ABLE 
TO COMMUNICATE. 

Select device type. 

Editable device name field. 

If checked, RCP will read the 

configuration from the device. 

Defaults to checked. 

Click to add device to project. 
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When the “Add” button is clicked you will see a popup that shows the progress of reading the device data. 
When the read is complete click “Close” to continue. 
 

5.1.2 Opening an Existing Project 

Select “Open Project…” if you want to retrieve an existing program file. A list of recent projects also 
appears under the Recent Project Files.  Clicking on one of these will open that project. It is 
recommended that you create a folder in which to save all programming files. When opening an existing 
project the user interface will automatically navigate to the last page that was visible when the project was 
saved. 
 

  CAUTION 

TO PROGRAM OR READ DATA FROM THE DEVICE, THE DEVICE MUST BE TURNED ON AND CONNECTED 
VIA USB. 

 
An existing project can be opened and modified without a device being connected.  Doing this permits a 
program to be modified offline and a device programmed at a later time. 
 

5.1.3 Recent Project Files 

Recently opened or saved project files are listed under the “Recent Project Files:” heading.  This gives 
the user a quick way to access project files.  Clicking on the project name will automatically open the 
project and all of the devices within the project. 
 
If the project file has been deleted or moved from the location where RCP saved it, then RCP will show 
an error if that project is clicked on.  The error window will indicate that the project is unable to be opened 
and ask if the user would like to remove the reference from the “Recent List”.  Clicking yes will only 
remove the reference from the list; it will not delete the file. 
 

5.2 Toolbar Menu Items 

5.2.1 Saving a Project 

To save a project, click the File menu at the top of the RCP screen to open the dropdown menu.  The 
user is then able to select “Save Project” or “Save Project As…”  If this is a new project, clicking on “Save 
Project” will open a dialog box prompting for the file location and name.  If this is an existing project, then 
clicking “Save Project” will save the project under the existing file name.  Clicking “Save Project As…” will 
permit the user to save the project under a different file name. 

Saving the project can also be done using the icon in the toolbar across the top. 
 

5.2.2 Reading the RCP Software Version 

1. Select “Help -> About”.  

2. The RCP Software Version number will be displayed.  
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5.2.3 Open Log File Directory 

Should customer service need to be contacted for a problem with RCP, the user may be asked to send a 
log file to assist in determining what the problem might be.  The log file contains debug information that 
will assist the factory in determining what the problem is. 

1. Select “Help -> Open Log File Directory”.  

2. This allows the user to easily find the log file when sending it to customer service if there is an 
issue. This opens an explorer window so the user can drag the log file into their email client when 
sending it to customer service. 

 

 
 

5.2.4 Removing control characters from the project file 

The 2.X version of RCP will prevent control characters from being written to the project file. A control 
character is a non-printable character that is not represented with a written symbol. This feature can be 
used if for some reason the RCD project file contains control characters. If the project file contains control 
characters, RCP will display an error when trying to open the project file. If this occurs, run this on the 
project file to remove the characters, and then reopen the project file; it will then load without error. 

1. Select “Help -> Select RCD file to remove control characters”. 

2. When removal is complete you will be notified. 
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5.2.5 Multi-Select 

Multiple channels in the workspace can be selected using the cursor to create a selection rectangle. The 
selection rectangle is created by clicking an unoccupied area in the workspace, then dragging the mouse 
so the desired channels intersect with the selection rectangle. The selection rectangle does not have to 
encompass the entire channel. 
 

 

 

The selected items can be moved as a group around the workspace, or the user can right-click on a 
single item or selected group to delete or copy. 
   

The initial click is done 
here. 

The selection rectangle is 
dragged through the 
channels and the mouse 
button is released here. 

Once the mouse button is 
released the selected 
channels will be shaded, 
indicating they are 
selected. 
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5.2.6 Right Click Options 

Items in the workspace can be right-clicked on to display a list of actions to be performed on the 
channel(s) selected. These options change depending on the selection. 
 

 
 

Figure 1: Single item right click vs. Multi item right click 

Delete Channel: Clicking this item in the list removes the channel from the workspace. 
 
Copy Channel: Creates a copy of the channel type that was clicked. No data is copied to the new 
channel, just the type of channel. 
 
After the copy is complete, the newly created items are selected so they can be moved around as a 
group.  
 
If multiple channels are selected then the “Copy Selected” option would copy the selected block of 
channels, and the “Delete Selected” option would remove the selected block from the workspace. 
 

Figure 2: Prior to alignment. 
 

Figure 3: After alignment. 
 
 
Align channel: Aligns the channels to the left-most channels in the group of selected channels. In the 
diagram above the lower two channels would shift left and be vertically aligned with the top channel. This 
menu item is disabled unless there are multiple channels selected. 
 
 
 

Shifted Left 

Shifted Left 



RCP 2.X Users Guide 
May 2014 

Page 16 of 85 

 

Figure 4: Right click connection options 

Delete Connection: Clicking this option deletes the input connection coming in the left hand side of the 
channel. 
 
Connect to: Connects the selected channel to the input side of the channel. Not all channels support 
right-click connection completion. 
 
Table 1: Hot Key Sequences 

Key Combination Description 

Crtl+C Copy selected channel(s) in the workspace. 

Ctrl+X Delete selected channel(s) in the workspace. 

Ctrl+A Vertically align the selected channels in the workspace. 

Ctrl+Shift+A 

Automatically moves any channels that have a negative x y 
coordinate to zero. This can occur if the channel group is 
moved and one of the channels could be moved out of the 
workspace. 

Crtl+S Saves the project. 

Ctrl+(Left Mouse Click) 
Adds the clicked channel to the selected group if the 
channel is not in the group. Removes the clicked channel 
from the selected group if the channel is selected. 

 

Delete Connection 

Click a menu item to 
connect to that device.  
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6 Devices 
A device is the physical piece of hardware that is being programmed, which can be either a transmitter or 
receiver.  Multiple devices may be added to a given project, making the project a collection of devices.  
The ability to have multiple devices within a project permits the user to easily switch between the various 
devices in order to see the different configurations and programming of related devices. 
 
The first device is automatically added to the project upon creation of the project.  Other devices can be 
added to the project by clicking on the File menu and choosing “Add” -> “New Device…”  This will bring 
up a new dialog menu permitting the user to choose another device to add to the project. 
 
The user interface and available device configuration tabs will vary between different device types.  The 
screenshot below shows the properties for an MHR.  Most Magnetek devices will have similar properties. 
 

 
 

Device level navigation is 
done using these tabs. 
This is the same as the 
previous versions of RCP. 

Page navigation for each 
device is done using these 
tabs. 
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6.1 Unit Info Tab 

 
 
The Unit Info Tab allows various I/O level changes to the device.  The properties that can be modified will 
vary based upon the device type. Table 2: Unit Info Properties shows the availability of properties per 
device type, while Table 3: Unit Info Field DescriptionsTable 3 gives a detailed description of each of the 
properties. 
 
NOTE: Changing any of these details will require a reboot of the attached device after the new 
information has been sent to the device for the change to take effect. 
   

Unit Info Properties Grid 

Unit Info Properties Help. 
This section displays help 
for the individual 
properties.
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Table 2: Unit Info Properties 

 MHR/MHC CAN-2/WIC-2402 inteleSmart2 

Frequency Read Only Read Only Read Only 

Access Code X X X 

RF Channel X X X 

RF Antenna X X X 

Rx Timeout X X X 

Client/Server N/A WIC-2402 Only N/A 

Device Name X X X 

Project ID Read Only Read Only Read Only 

Serial Number Read Only Read Only Read Only 

Device Memory Used Read Only Read Only Read Only 

Expansion Board 1 N/A N/A Read Only 

Expansion Board 2 N/A N/A Read Only 

Program Loaded Read Only Read Only Read Only 

Activate Password X N/A N/A 

PWM Frequency X N/A N/A 

Update Date/Time X N/A N/A 

ESTOP Configuration N/A CAN-2 Only N/A 

NOTE: Some versions of RCP will permit the changing of the Project ID field.  The factory will determine if 
a user is eligible for a version with this ability. 
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Table 3: Unit Info Field Descriptions 

Field  Description 
Frequency  A read-only property displaying the Radio Frequency of the device. This is set 

by the factory and hardware configuration, and cannot be modified by the user.
Access Code  The access code acts as the receiver address.  The receiver will only listen to 

transmitters with the same access code. 
 
NOTE: The transmitter must be set with the same access code as the receiver 
to properly communicate with each other. 
 
Range: 1-1048575 

RF Channel  The RF channel is user-selectable through the pull-down menu. This function is 
used to prevent interference with other radio devices.  
 
Refer to Section 8 for additional information on channels and the exact 
frequency for each frequency range. 
 
Depending upon the installation, there might be special frequency channels 
shown. 

RF Antenna  This section allows the user to select between utilizing the internal antenna that 
is built into the receiver or utilize the external antenna attachment (if available). 
 
The antenna selection can be Internal or External (if supported). 

Rx Timeout  The amount of time before the device shuts down after not receiving a message 
from the transmitter. 
 
Range: 450-3000ms

Client/Server  The operation mode of the WIC-2402 device. This field may be read-only if the 
device is pre-defined.

Device Name  The device name field allows the user to create a custom name for the receiver. 
 
The name can be up to 16 ASCII characters long.

Project ID  This section displays the Project ID for the device. 
The Project ID is set by the factory and cannot be modified by the user.  
 
Range: 1-65535 

Serial Number  This section displays the serial number for the unit. 
 
The serial number of the unit is set by the factory and cannot be modified by the 
user. 

Device Memory Used  A read-only property showing the percentage of memory allocated for custom 
mapping. 

Expansion Board 1  A read-only field that displays the type of expansion board that is connected.
Expansion Board 2  A read-only field that displays the type of expansion board that is connected.
Program Loaded  A read-only property showing if a user-defined map is loaded in the system.
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Activate Password  The password is used to restrict access to the configuration menu on the 
device. Having an active password prevents accidental changes to the device 
configuration. 
 
NOTE: Please familiarize yourself with this section before programming the 
password.  
 
The password default setting is to be disabled during initial programming by the 
RCP software. To enable password protection, check the box next to the phrase 
“Activate password.”  
 
If you choose to enable the password function, you can create a new password 
by selecting a four digit numerical password using numbers from 0 to 9. Be sure 
to write this password down in a safe place for future reference.  

PWM Frequency  The Pulse Width Modulation (PWM) Frequency is the frequency that the outputs 
will operate at when configured for either open loop or current compensated 
mode. This feature can be selected by the user using a range from 33 to 1000 
Hz (Open loop) or 75 to 1000 Hz (Closed loop). 

Update Date/Time  The user can match the device time to the PC time or choose to set a time other 
than the time on the PC.

ESTOP 
Configuration 

This field allows the user to define how the ESTOP/Output pins are configured. 
 The pins can be configured as: 

o ESTOP1 - ESTOP2  
o ESTOP1 - Digital Output 2 
o Digital Output 1 - Digital Output 2 

 

WARNING 
THE ACCESS CODES IN THE RECEIVER ARE UNIQUE AND FACTORY PRESET. DO NOT CHANGE THESE 
ACCESS CODES UNLESS YOU ARE REPLACING AN EXISTING RECEIVER AND ITS ACCESS CODE. 
CHANGING THIS CODE COULD MAKE IT COMMON WITH ANOTHER RECEIVER ACCESS CODE, WHICH 
COULD MOVE OTHER EQUIPMENT. NO TWO SYSTEMS IN ANY LOCATION SHOULD EVER HAVE THE SAME 
ACCESS CODES INDEPENDENT OF FREQUENCY. FAILURE TO FOLLOW THIS WARNING COULD RESULT IN 
SERIOUS INJURY OR DEATH, AND DAMAGE TO EQUIPMENT. 

 

WARNING 
ALWAYS REMEMBER TO STORE THE PASSWORD IN A SECURE LOCATION FOR ACCESS IF THE 
PASSWORD IS LOST OR FORGOTTEN. ONCE THE DEVICE IS PROGRAMMED WITH A PASSWORD, THERE IS 
NO WAY TO DEFEAT THE PASSWORD WITHOUT USING THE RCP SOFTWARE TO EITHER READ THE 
PASSWORD OR REPROGRAM A NEW PASSWORD. 
 

WARNING 
THIS PASSWORD FUNCTION IS NOT TO BE USED AS A SECURITY DEVICE. THE PURPOSE OF THIS 
FUNCTION IS TO PREVENT ACCIDENTAL CHANGES TO THE RECEIVER SETTINGS. THE BEST FORM OF 
SECURITY IS ALWAYS TO LOCK UP THE DEVICE WHEN NOT IN SERVICE. FAILURE TO FOLLOW THIS 
WARNING COULD RESULT IN SERIOUS INJURY OR DEATH AND DAMAGE TO EQUIPMENT. 
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WARNING 
NOT ENABLING THE PASSWORD FUNCTION ALLOWS THE DEVICE SETTINGS TO BE MODIFIED BY ANY 
UNAUTHORIZED USER(S). IMPROPER DEVICE SETTINGS COULD RESULT IN SERIOUS INJURY OR DEATH 
AND DAMAGE TO EQUIPMENT. 

 

6.1.1 Device Block Diagram and Pin Properties Grid 

The middle section of the Unit Info tab will display a block diagram of the device to be programmed. The 
block diagram is interactive and will change what is displayed in the pin properties grid on the right side. 
 
In these screenshots the device being programmed is an MHR. For programmable devices the screen will 
have a similar layout. 
 

 
 
 
When programming I/O (specific to devices that have configurable I/O),    

A selection here… 

… changes the properties 
that are displayed in the 
grid. 
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Table 4 describes which parameters are configurable for each of the output types. These properties can 
be modified using the property grid. 
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Table 4: Available Properties Based on I/O Type 

I/O Type Property 
  Min 

Current 
Max 
Current 

Start 
Ramp 

Stop 
Ramp 

Min Duty 
Cycle 

Max Duty 
Cycle 

Output Digital Momentary N/A N/A N/A N/A N/A N/A 
Output Digital Latched N/A N/A N/A N/A N/A N/A 
Output PWM Open N/A N/A X X X X 
Output PWM Closed X X X X N/A N/A 
Input PWM N/A N/A N/A N/A N/A N/A 
Input Digital N/A N/A N/A N/A N/A N/A 
 

6.1.2 CAN Configuration 

For devices with configurable CAN, the figure below shows the selection of the CAN 1 bus and the grid 
changes to the configurable properties of the CAN bus. This allows the user to modify the CAN bus 
network communication settings by selecting which CAN bus to configure. 
 

 
 

Figure 5: CAN1 Bus Configuration (MHR) 
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Figure 6: CAN Bus Configuration Page (CAN-2) 

Table 5: CAN Configuration 

CAN Field Description 

Source Address This is the address that the device will use as the source address when 
transmitting messages on the CAN bus network. 

Baud Rate This pull-down menu allows the user to modify the communication speed of the 
CAN bus network. The user selectable options are 50k, 125k, 250k, and 500k.  

Protocol Type The protocol used to communicate on the CAN bus. 
Options: J1939/CAN Open/Parker ICP/High Country Tek DN/OEM Controls DN 
 
NOTE: Not currently supported by any product. 

Identifier The number of bits in the frame. 
Options: 11bits/29bits 
 
NOTE: Not currently supported by any product. 

Terminating 
Resistor 

Selects whether an internal terminating resistor or an external terminating 
resistor is used. Selecting Internal will enable the internal terminating resistor. 
Selecting External will disable the internal terminating resistor. 
 
NOTE: Not all devices have the termination resistor set via software.  This 
setting is only applicable to the devices that have this set via software.  Please 
refer to the instruction manual for your device to determine how this setting can 
be modified. 
 
Options: Internal/External 

Enable PGN 65410 Enable/Disable Status PGN 65410 (Available in CAN-2 only). See Appendix A 
Enable PGN 65411 Enable/Disable Status PGN 65411 (Available in CAN-2 only). See Appendix A 
Enable PGN 65412 Enable/Disable Status PGN 65412 (Available in CAN-2 only). See Appendix A 
Enable PGN 65413 Enable/Disable Status PGN 65413 (Available in CAN-2 only). See Appendix A 
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Enable PGN 65414 Enable/Disable Status PGN 65414 (Available in CAN-2 only). See Appendix A 
Enable PGN 65415 Enable/Disable Status PGN 65415 (Available in CAN-2 only). See Appendix A 
Enable PGN 65416 Enable/Disable Status PGN 65416 (Available in CAN-2 only). See Appendix A 
 

6.1.3 Analog Input Configuration 

For devices with configurable analog inputs, the following properties are configurable through the property 
grid if one of the analog inputs is selected. 
 
Table 6: Analog Input Configuration 

Analog Field Description 
Input Type 
(Analog/Digital) 
 

Digital – the voltage on the input will be represented as a digital value 
based on the thresholds. 
Analog – the voltage on the input will be represented as its 10-bit analog 
value. 

On Threshold Digital (voltages above this value will be a digital high) 
Off Threshold Digital (voltages below this value will be a digital low) 
Minimum Voltage Analog (the minimum operating voltage of the device connected to the 

input) 
Maximum Voltage 
 

Analog (the maximum operating voltage of the device connected to the 
input) 

NOTE: The range for the analog input pins are 0-13.2 volts. 
 

6.1.4 Sending Device Configuration 

WARNING 
AFTER EVERY PROGRAMMING OF THE RECEIVER, TEST THE UNIT BY UTILIZING THE APPROPRIATE 
TRANSMITTER. IF THE RECEIVER DOES NOT RESPOND, DO NOT ACTIVATE A FUNCTION BUTTON! 
 
THE RECEIVER MAY HAVE INCORRECT PROGRAMING. RE-CHECK THE PROGRAMMING IN THE RECEIVER 
AND RETEST. AFTER ACTIVATION OF THE RECEIVER, FUNCTIONALLY TEST ALL COMMANDS ON THE 
TRANSMITTER BY INITIALLY JOGGING THE BUTTONS, WITH A FULL MOVEMENT, BEFORE RETURNING TO 
SERVICE. FAILURE TO FOLLOW THIS WARNING COULD RESULT IN SERIOUS INJURY OR DEATH AND 
DAMAGE TO EQUIPMENT. 

 
To send a program file to a device: 
 

1. Plug in the USB programming cable or position. 

NOTE: Reference the specific device manual for details on connecting the USB cable. 
 

2. Click the “Send” button on the RCP screen. A dialog box will pop up confirming that you want to 
proceed. Check the box marked “I accept,” and then click the button “Continue send to radio.” 
On-screen prompts will confirm that the receiver has been programmed or if there are any issues.  
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6.1.5 Receiving Device Configuration 

To read a program file from a device:  
 

1. Plug in the USB programming cable or position. 

NOTE: Reference the specific device manual for details on connecting the USB cable. 
 

2. Click “Receive” and follow the on-screen prompts.  

3. RCP will confirm reception and automatically display current programming in the unit. 

 
NOTE: This will only receive the unit settings.  To receive the logic programming information refer to 
Section 6.2.2. 

 

6.1.6 Resetting the Device to Factory Default Settings 

Resetting to factory defaults will set the device configuration back to the settings that it was sent from the 
factory with.  This feature is only available for programs that are written by the factory. 

1. Plug in the USB programming cable or position. 

NOTE: Reference the specific device manual for details on connecting the USB cable. 
 

2. Select the “Reset to Defaults” button.  

3. A dialog box will pop up, confirming that you want to proceed. Click the button “OK” to restore the 
factory default settings. On-screen prompts will confirm that the receiver has been reset to 
defaults or if there are any issues.  

4. Power cycle the device to implement the factory default values. 

 

 
 

6.2 Programming Tab 
The programming tab page allows the user to map inputs and outputs in the device. The physical inputs 
can be mapped to physical outputs on the device; alternatively, you can perform a mathematical 
operation on the input and then direct the result of the mathematical operation to an output channel.  For 
specifics on programming each type of device, please refer to Section 7. 
 
NOTE: The device must be running a specific version of the hex file for it to accept and run the 
programmed created for it. There are special versions of firmware for the MHR, inteleSmart2 and CAN 
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receivers. Please contact customer service for details on obtaining the firmware for those receivers. 
These files are loaded via the FDP tab. See the FDP Tab Page (Section 6.3) for instructions on how to 
update the firmware. 
 

6.2.1 Programming Tab Layout 

 
 

Figure 7: Programming Tab Layout 

 
The programming page is broken into three sections: 
 

 Selection Area – This area is where the user adds Commands, Functions, and I/O to the 
workspace. 

 Workspace Area – This area is where the user gets a visual representation of the mapping 
configuration. 

 Property Grid – This area is populated with a list of properties that are associated with each of 
the Commands, Functions, and I/O.  Each of the properties in the grid can be selected to view a 
description of that property. 

 

Property Grid 

Selection Area 

Workspace 
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Figure 8: How to Display Help for a Channel Property 

Within the property grid there is a section at the bottom that display “help” information about the property.  
This information is meant to give an overview of what is input expected for that property. 
 

6.2.2 Programming Tab Button Functions 

  
 

Figure 9: Functions Available on the Programming Tab 

Compile Button – This button compiles the channel paths so they can be sent to the device. 
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Send Button – Sends the configuration to the device. This sends mapping information along with the 
device and I/O configuration. 
 
Receive Button - Receives the information from the device to populate the workspace and the channels 
information. 
 
Use Default Map Button – Used only with the inteleSmart2 receiver. This button sends the receiver into 
a default mapping mode that is embedded into the device’s firmware file. 
 
Align Selected Button – Aligns the selected channels to the left most channel in the group. This only 
works if there are multiple channels selected. 
 
Clear Workspace Button – Removes all of the channels from the workspace. Data will be lost as soon 
as the project is saved. 
 

6.2.3 Channel Selection Tab Groups 

NOTE: Not all channel types are available for all devices.  Refer to Section 7 for specifics on each device. 
 
The property grid on the right changes based on what type of channel is selected in the workspace area. 
 
When the programming tab page is active, channels can be added to the workspace by clicking on the 
channels displayed on each of the tabs. 
 

 
 

Figure 10: RF Message Channels 

 

 
 

Figure 11: CAN Related Channels 
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Figure 12: Math Operations Channels 

 

 
 

Figure 13: I/O, Constant, and Analog Inputs Channels 

 

 

Figure 14: Library Commands 

The library commands assist the user by automatically constructing a commonly used set of channels. 
See the following page for examples of each of the library functions. 
 
When the library group is placed in the workspace, the group is selected so it can be easily dragged to a 
new location. All library groups are added to the workspace in the same location, so they must be moved 
or they will overlap with other channels in the workspace. 
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Figure 15: PGN In -> 8 bytes Command. 

 

 

Figure 16: 8 bytes => PGN Out Command. 

 

 

Figure 17: RFCmd Digital In => 8 bits Command 
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Figure 18: RFCmd => Matrix => Relays 
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6.3 FDP Tab Page 
The Firmware Download Programmer (FDP) is a utility that allows firmware to be loaded on to a device 
via USB. 
 

WARNING 
 
THERE CAN BE ONLY ONE DEVICE CONNECTED VIA USB WHEN USING FDP. 

 
 

 
 

Figure 19: Screen capture of the FDP tab page. 

NOTE: If you navigate away from the FDP tab page and the device has been restarted but is not showing 

in the device list, try clicking the Discover Devices button  located in the upper left hand corner of the 
tab page. 
 
 
 
 



RCP 2.X Users Guide 
May 2014 

Page 35 of 85 

WARNING 
 
THE USER IS RESPONSIBLE FOR LOADING THE CORRECT FIRMWARE ON THE DEVICE. DEVICE BEHAVIOR 
IS UNKNOWN IF THE WRONG FIRMWARE IS LOADED ON THE DEVICE. LOADING FIRMWARE FOR ANOTHER 
TYPE OF DEVICE CAN CAUSE THE DEVICE TO BE INOPERABLE.  

 

6.3.1 Steps to Load Firmware 

1. Click the “ResetDevice” button to place the device in to bootloader mode.  
a. Placing the device in bootloader mode allows firmware to be loaded on the device. 
b. Once the device is reset the other buttons will be enabled. 
c. The text area will be updated with the status of the reset. 

2. Click “Open Hex File” (this will open an Open File Dialog window). 
a. Navigate to the appropriate folder and select the firmware file to load on the device. 
b. The text area will show that the file has been loaded. 

3. Click “Program Device”. 
a. The text area will display the status of the firmware load and display a message stating 

that the firmware has completed. 
4. Once the firmware has been programmed, the device can be reset by clicking on “Reset Device” 

to run the newly loaded firmware. 

   



RCP 2.X Users Guide 
May 2014 

Page 36 of 85 

7 Device Programming 

7.1 How to Create Mapping 
Mapping is connecting inputs to outputs. 
 

Incoming Radio Messages

Incoming CAN Messages

Analog Input

Digital Input

Outgoing CAN Messages

PWM Output

Digital Output

Optional Logic  
Operations

Inputs Outputs

 
 

Depending on the device the number and type of Inputs and Outputs will vary. 
 

7.1.1 Channel Image Field Description 

 
 
   

This field contains the name 

of the channel. The user 

can modify this field 

through the property grid. 

This field is specific to an 

I/O type channel showing 

how the I/O is configured. 

This field displays the type 

channel. 

This field displays the unique ID of 

the channel. This field helps identify 

the channel when selecting it with 

the dropdowns when connecting 

them. 
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7.1.2 Connection Limits 

Mathematical objects (Arithmetic/Relational/Logical) are limited to five consecutive objects connecting to 
each other (see Figure 20: Math Operator Limits for example). 
 

 
 

Figure 20: Math Operator Limits 

Other connection limits are based on the type of input they can accept and what value the object 
produces as output. The object’s input type is predefined and can only connect to objects that have an 
output of that type. All the objects that have that output type are listed in the dropdown boxes for that 
object. 
 

 
Figure 21: Workspace view of math operation. 

 

 
Figure 22: The equation is shown in the Notes field. 

7.1.3 Channel Limits 

Table 7 lists the maximum number of channels that can be programmed via RCP per device.  
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Table 7: Channel Limits 

Device Maximum Number of Channels 
MHR/MHC 192 (Firmware prior to version 3.1.0 can only 

support 64 channels) 
CAN-2 192 
inteleSmart2 192 
 

7.1.4 Channel Connection Description 

The connections in the workspace describe how data will flow and how it is manipulated prior to being 
used in an output channel.  
 

 
 

Figure 23: Types of Channels 

The following describes all of the available channel types.  For each type there is a description of what 
the channel is, the channel size (the bit size of the channel), what types of channel inputs can be mapped 
to the channel, and the devices this channel type is supported on. 
 

7.1.4.1 Analog Input Channel 

Description: The analog input channel is used to measure an analog value and convert it into a digital 
value that can be used as input to other channels.  Refer to the product manual for each device to 
determine what types of analog inputs are supported. 
Value Size: 10 bits 
Supported Input Connection Types: Mapped to physical hardware 
Supported Devices: MHR, MHC, inteleSmart2 
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7.1.4.2 Digital Input Channel 

Description: The digital input channel is used to determine if there is a voltage on an input pin. If there is 
a voltage present, the digital input will be high; otherwise the input will be low.  The value can then be 
used as input to other channels. 
Value Size: 1 bit 
Supported Input Connection Types: Mapped to physical hardware 
Supported Devices: MHR, MHC, inteleSmart2 
 

7.1.4.3 Digital Output Channel 

Description: The digital output channel is used to set the voltage level on the output connection 
configured by the channel properties. 
Value Size: 10 bits (MHR/MHC) (any value greater than 0 will be represented as digital high) 
1 bit (inteleSmart2 and CAN-2) 
Supported Input Connection Types: IO (input), Math, Pin (CAN parameter in), RF Command (in), RF 
Digital Bits (in), Constant, Scaling 
Supported Devices: MHR, MHC, inteleSmart2, CAN-2 
 

7.1.4.4 PWM Output Channel 

Description: These channels will output a PWM signal that is either open loop PWM or current 
compensated PWM (closed loop).  The PWM frequency is set in the Unit Info screen.  Refer to Section 
6.1 for additional information on how to set this. To set this output type, select the I/O channel type and 
choose one of the PWM output types. 
Value Size: 10 bits 
Supported Input Connection Types: IO (input), Math, Pin (CAN parameter in), RF Command (in), RF 
Digital Bits (in), Constant, Scaling 
Supported Devices: MHR, MHC 
 

7.1.4.5 Analog To Step Channel 

Description: Converts an 8 bit analog value (0-255) into a discrete step value used as input to a matrix 
channel.  This is typically used to convert analog RF Command values from a proportional transmitter into 
values that make it look like a transmitter sending discrete step values. 
Value Size: 8 bit 
Supported Input Connection Types: Math, Constant, RFIn, RF Dig In 
Supported Devices: inteleSmart2 
 

7.1.4.6 Matrix Channel 

Description: Makes configuring relays simpler by grouping them and allowing them to be driven via input 
without the need for additional math channels. 
Value Size: - Input: (1-12) 1-bit values 
- Input: (2) 8-bit values 
- Output: (1-12) 1-bit outputs 
Supported Input Connection Types: IO (input), Math, Pin (CAN parameter in), RF Command (in), RF 
Digital Bits (in), Constant, Scaling, Analog To Step 
Supported Devices: inteleSmart2 
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7.1.4.7 Math Operator Channel 

Description: Performs math operation on an input or number of inputs.  The available math operator 
channels are: Greater Than, Greater Than Or Equal To, Less Than, Less Than Or Equal To, Not Equal, 
Equals, Addition, Subtraction, Multiplication, Division, NOT, AND, OR, XOR.  All of the relational 
operators output a 1 bit value while all other operators will output a 16 bit value. 
Value Size: 16 bits 
Supported Input Connection Types: IO (input), Math, CAN (Parameter in), RF Command (in), RF 
Digital Bits (in), Constant, Scaling 
Supported Devices: MHR, MHC, inteleSmart2, CAN-2 
 

7.1.4.8 CAN Parameter Group (Input) Channel 

Description: There are two types of PG Input channels, J1939 PG In and Generic PG In.  One is used 
for J1939 CAN messages and the other can be used for all other CAN message protocols.  This channel 
type then needs to connect to parameter input channels (Param In), which will provide access to the data 
within the CAN message. 
Value Size: 64 bits (8 bytes of CAN Data) 
Supported Input Connection Types: Message directly coming in from the CAN bus 
Supported Devices: MHR, MHC, inteleSmart2, CAN-2 
 

7.1.4.9 CAN Parameter Group (Output) Channel 

Description: There are two types of PG Output channels, J1939 PG Out and Generic PG Out.  One is 
used for J1939 CAN messages and the other can be used for all other CAN message protocols.  This 
channel type configures the header information for the CAN message before transmission. 
Value Size: 64 bits (8 bytes of CAN Data) 
Supported Input Connection Types: Param Out 
Supported Devices: MHR, MHC, inteleSmart2, CAN-2 
 

7.1.4.10 CAN Parameter (Input) Channel 

Description: Used to parse data from an incoming CAN message. 
Value Size: 1-8 bits (selectable through property) 
Supported Input Connection Types: J1939 PG In, Generic PG In 
Supported Devices: MHR, MHC, inteleSmart2, CAN-2 
 

7.1.4.11 CAN Parameter (Output) Channel 

Description: Used to capture/format data for an outgoing CAN message. 
Value Size: 1-8 bits (configured through property) 
Supported Input Connection Types: IO (Input), Math, CAN (Parameter In), Constant, RF Command, 
RF Command Digital Byte Bits (In), Scaling 
Supported Devices: MHR, MHC, inteleSmart2, CAN-2 
 

7.1.4.12 RF Command Input Channel 

Description: Used to access the data from incoming RF messages. 
Value Size: 8 bits 
Supported Input Connection Types: Incoming Radio Messages 
Supported Devices: MHR, inteleSmart2, CAN-2 
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7.1.4.13 RF Digital Bits Input Channel 

Description: Used to parse individual bits from an incoming RF command that is configured as a digital 
command. 
Value Size: 1-8 bits (configured through property) 
Supported Input Connection Types: Incoming Radio message channels configured as digital 
Supported Devices: MHR, inteleSmart2, CAN-2 
 

7.1.4.14 Scaling Channel 

Description: Used to redefine the input values of the channel. For example, this channel can be used to 
convert an 8-bit value to a 10-bit value. 
Value Size: Varies depending upon the configuration (16 bit max) 
Supported Input Connection Types: IO (Input), Math, CAN (Parameter In), Constant, RF Command, 
RF Command Digital Byte Bits (In), Scaling 
Supported Devices: MHR, MHC, inteleSmart2, CAN-2 
 

7.1.4.15 Constant Channel 

Description: Used to define a literal value or a percentage. When defined as a percentage it can only be 
used for as input to relational type math channels. i.e. ==, != >, <, >=, <=  
All operations are performed using integer math resulting in a loss of precision. 
Value Size: Varies depending upon the configuration (16 bit max) 
Supported Input Connection Types: There are no inputs to this channel type 
Supported Devices: MHR, MHC, inteleSmart2, CAN-2 
 

7.2 Transmitter Component to RF Message Mapping 
The location in which switches are plugged into an I/O board of a transmitter determines how the data 
from the switch is sent to the receiver.  The decoding of this data is mapped differently depending on the 
type of I/O board being utilized.  Section 7.2.1 shows the physical connections of each of the I/O boards 
that have the ability for a user to change how components are plugged in.  Section 7.2.2 shows the 
mapping of the I/O board connections to the RF commands.  Information from both of these sections is 
required to properly determine how a connection into an I/O board will be decoded on the receiver. 
 

7.2.1 Transmitter I/O Connections 

Table 8: I/O Board Part Numbers shows the part numbers required for each of the I/O boards to properly 
support the RF command mapping.  Other part numbers for different I/O boards exist, but may not 
properly support the standard RF command mapping.  There may also be some software changes 
required to properly support the mapping.  If the connections are not mapping as expected, contact 
customer support to ensure the required software is loaded on the device. 
 
Table 8: I/O Board Part Numbers 

Device Part Numbers 
XLTX I/O 25-08-052-205E 
MLTX2 I/O 25-10-122-202E 
MBT/PGT Toggle 25-09-052-208E 
MBT/PGT Generic 25-09-052-202E Rev. 2 
 
For example (using Figure 24), if a toggle is connected into T12, look up the MLTX2 transmitter in the 
Mapping table and see what Command Function is mapped to contain the T12 data. In this example, the 
toggle data for T12 is received in Command Function Digital Byte 2, in bit 6 for toggle position A and bit 7 
for toggle position B.  
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NOTE:  Similar connections are laid out the same for each of the connection types. 
 
Table 9: Pin out Legend 

Connection Definition 
VCC Source Voltage 
P_COM Ground 
Direction#A/B Digital Connection that determines the direction of the paddle. 
Motion# Analog Input 
Analog# Analog Input 
Rotary# Digital Input connection for each of the rotary positions 
Toggle# Digital input for a toggle connection 
 

 
 

Figure 24: MLTX2 Labeled Toggle Connections (Side 1) 

To map a paddle’s forward and reverse motion when the paddle is plugged into the Motion1 connection, 
two channels are required in RCP to handle the forward and the reverse motions. To determine how the 
channels are configured, refer to Table 10, Table 11, and Table 12 to determine the Command Function 
values. From the table, you see that the forward motion maps to Command Function 1 and the reverse 
motion maps to Command Function 2. 
 
For the Analog connection there are various components that can connect to this connection. The analog 
pins on the connector map to Analog Functions 9-13 when configuring the RF channel in RCP. 
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Figure 25: MLTX2 Motion and Analog Connections (Side 2) 

 

 
 

Figure 26: XLTX Connections (Side 1) 

When connecting a dial to the POT0 connection on an XLTX, the RF Command channel in RCP would be 
configured as Analog and the Function property would be Function 1. 
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Figure 27: Dial connected to POT0 as seen through RCP property configuration 

 

 

Figure 28: XLTX (Side 2) 

Side 2 contains the connections for the Rotary switch, Buzzer, Display board and LEDs 1-4. 
 



RCP 2.X Users Guide 
May 2014 

Page 45 of 85 

 
 

Figure 29: MBT/PGT Toggle Board (Side 1) 

NOTE:  Similar connections are laid out the same for each of the connection types. The orientation is the 
same for each of the 6 hole connector pads. 
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Figure 30: MBT/PGT Toggle Board (Side 2) 

NOTE:  Similar connections are laid out the same for each of the connection types. The orientation is the 
same for each of the 3 hole connector pads. 
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Figure 31: MBT/PGT Generic IO Board (Side 1) 
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Figure 32: MBT/PGT Generic I/O Board (Side 2) 

 

7.2.2 Transmitter Radio Message Mapping 

This table shows the typical Command Function mappings for each of the transmitters.  The Command 
Functions represent connections on the I/O board inside the transmitter. 
 
The Command Function column directly corresponds to connectors on the transmitter I/O boards. See 
Transmitter I/O Connections (Section 7.2.1) to see the physical connector on the various I/O boards.  
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Table 10: Motion Commands 

RF Command In  Transmitter PCB Connections

Function  RF Command  XLTX I/O  MLTX2 I/O Flex Pro Flex VUE Flex EM Flex EX  MBT/PGT I/O

Function1  Motion  Motion1‐ Dir#A  Motion1‐ Dir#A Button1 Button1 Button1 Button1  Motion1‐ Dir#A

Function2  Motion  Motion1‐ Dir#B  Motion1‐ Dir#B Button2 Button2 Button2 Button2  Motion1‐ Dir#B

Function3  Motion  Motion2‐ Dir#A  Motion2‐ Dir#A Button3 Button3 Button3 Button3  Motion2‐ Dir#A

Function4  Motion  Motion2‐ Dir#B  Motion2‐ Dir#B Button4 Button4 Button4 Button4  Motion2‐ Dir#B

Function5  Motion  Motion3‐ Dir#A  Motion3‐ Dir#A Button5 Button5 Button5 Button5  Motion3‐ Dir#A

Function6  Motion  Motion3‐ Dir#B  Motion3‐ Dir#B Button6 Button6 Button6 Button6  Motion3‐ Dir#B

Function7  Motion  Motion4‐ Dir#A  Motion4‐ Dir#A Button7 Button7 Button7 Button7  Motion4‐ Dir#A

Function8  Motion  Motion4‐ Dir#B  Motion4‐ Dir#B Button8 Button8 Button8 Button8  Motion4‐ Dir#B

Function9  Motion  Motion5‐ Dir#A  Motion5‐ Dir#A Button9 Button9 Button9 Button9  Motion5‐ Dir#A

Function10  Motion  Motion5‐ Dir#B  Motion5‐ Dir#B Button10 Button10 Button10 Button10  Motion5‐ Dir#B

Function11  Motion  Motion6‐ Dir#A  Motion6‐ Dir#A Button11 Button11 Button11 Button11  Motion6‐ Dir#A

Function12  Motion  Motion6‐ Dir#B  Motion6‐ Dir#B Button12 Button12 Button12 Button12  Motion6‐ Dir#B

Function13  Motion  Motion7‐ Dir#A  Motion7‐ Dir#A   Motion7‐ Dir#A

Function14  Motion  Motion7‐ Dir#B  Motion7‐ Dir#B   Motion7‐ Dir#B

Function15  Motion  Motion8‐ Dir#A    Motion8‐ Dir#A

Function16  Motion  Motion8‐ Dir#B    Motion8‐ Dir#B

 
Table 11: Digital Commands 

RF Command In  RF Digital Bit In  Transmitter PCB Connection 

Function  RF Command 
Starting 

Bit 
Length 

XLTX 
I/O 

MLTX2 
I/O 

MBT/PGT 
Toggle 

MBT/PGT 
Generic 

Function 1  Digital 

0  1  A‐T1  A‐T1    A‐T1 

1  1  B ‐T1  B ‐T1    B ‐T1 

2  1  A‐T2  A‐T2    A‐T2 

3  1  B ‐T2  B ‐T2    B ‐T2 

4  1  A‐T3  A‐T3    A‐T3 

5  1  B ‐T3  B ‐T3    B ‐T3 

6  1  A‐T4  A‐T4  A‐T4  A‐T4 

7  1  B ‐T4  B ‐T4  B ‐T4  B ‐T4 

Function 2  Digital 

0  1  A‐T5  A‐T5  A‐T5  A‐T5 

1  1  B ‐T5  B ‐T5  B ‐T5  B ‐T5 

2  1  A‐T6  A‐T6  A‐T6A   

3  1  B ‐T6  B ‐T6  B ‐T6A   

4  1  A‐T7  A‐T7  A‐T7   

5  1  B ‐T7  B ‐T7  B ‐T7   

6  1  A‐T8  A‐T8  A‐T8   

7  1  B ‐T8  B ‐T8  B ‐T8   

Function 3  Digital 

0  1  A‐T9  A‐T9  A‐T9   

1  1  B ‐T9  B ‐T9  B ‐T9   

2  1  A‐T10  A‐T10  A‐T10A   

3  1  B ‐T10  B ‐T10  B ‐T10A   

4  1  A‐T11  A‐T11  A‐T11   

5  1  B ‐T11  B ‐T11  B ‐T11   

6  1  A‐T12  A‐T12  A‐T12   

7  1  B ‐T12  B ‐T12  B ‐T12   

Function 4  Digital 

0  1  A‐T13  A‐T13   

1  1  B ‐T13  B ‐T13   

2  1  A‐T14  A‐T14   

3  1  B ‐T14  B ‐T14   

4  1  A‐T15  A‐T15   

5  1  B ‐T15  B ‐T15   

6  1  A‐T16  A‐T16   

7  1  B ‐T16  B ‐T16   

Function 5  Digital 

0  1  A‐T17  A‐T17A   

1  1  B ‐T17  B ‐T17A   

2  1  A‐T18  A‐T18A   

3  1  B ‐T18  B ‐T18A   

4  1  A‐T19     

5  1  B ‐T19     

6  1  A‐T20     

7  1  B ‐T20     
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RF Command In  RF Digital Bit In  Transmitter PCB Connection 

Function  RF Command 
Starting 

Bit 
Length 

XLTX 
I/O 

MLTX2 
I/O 

MBT/PGT 
Toggle 

MBT/PGT 
Generic 

Function 6  Digital 

0  1     

1  1     

2  1     

3  1     

4  1     

5  1     

6  1     

7  1     

Function 7  Digital 

0  1     

1  1     

2  1     

3  1     

4  1     

5  1     

6  1     

7  1     

Function 8  Digital 

0  1  RotaryA  RotaryA     

1  1  RotaryB  RotaryB     

2  1  RotaryC  RotaryC     

3  1  RotaryD  RotaryD     

4  1  RotaryE  RotaryE     

5  1  RotaryF  RotaryF     

6  1     

7  1     

Function 9  Digital  8bits           

Function 10  Digital  8bits           

Function 11  Digital  8bits           

Function 12  Digital  8bits           

Function 13  Digital  8bits           

Function 14  Digital  8bits           

Function 15  Digital  8bits           

Function 16  Digital  8bits           

 
Table 12: Analog Commands 

RF Command In  Transmitter PCB Connections

Function  RF Command  XLTX I/O  MLTX2 I/O

Function1  Analog  Analog0‐Pot0  Analog0‐Pot0

Function2  Analog  Analog1‐Pot1  Analog1‐Pot1

Function3  Analog       

Function4  Analog       

Function5  Analog       

Function6  Analog       

Function7  Analog       

Function8  Analog       

Function9  Analog  Analog2/A  Analog2/A

Function10  Analog  Analog3/B  Analog3/B

Function11  Analog  Analog4/C  Analog4/C

Function12  Analog  Analog5/D  Analog5/D

Function13  Analog  Analog6/E  Analog6/E

Function14  Analog     

Function15  Analog     

Function16  Analog       
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7.2.3 Transmitter Button Layout 

 

Figure 33: Flex VUE 

Image Button Number Function Number (see Transmitter Radio Message 
Mapping) 

1 Function 1 
2 Function 2 
3 Function 3 
4 Function 4 
5 Function 5 
6 Function 6 
7 Function 7 
8 Function 8 
9 Function 9 
10 Function 10 
11 Function 11 
12 Function 12 

 
The Flex EX and Flex EM transmitters also follow the same button layout as the Flex VUE shown above. 
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7.3 Examples 

7.3.1 Digital Input to Digital Output 

This section will show a very basic mapping which will take a digital input on a device and map it directly 
to a digital output on a device.  A mapping of this nature will be uncommon, but this is intended to show 
the basics of how programming a device is accomplished.  Further sections will get into more detail with 
additional mapping options and features. 
 

 
 
 

 

Click to add I/O to

workspace. 

I/O added to workspace.
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When the project was created, the option to read device data was checked, so the device configuration 
will be used when a selection is made. 

Click and drag channel to 

new location in workspace. 
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Click in the textbox and 

enter the I/O number. 

The channel will change to 

match the configuration of 

the device. 
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Next steps: (same steps as done for Output #9 channel) 
 

 Drag the new channel near the Output #9 channel. 

 Select the I/O number that matches the configuration you are creating.  

 
The next screenshot will show these step already completed.  
 

Click the I/O button to add another channel to the workspace.

The new channel appears in the workspace.
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Click the channel to display properties. 

Click on the Input Control property. This 
displays a list of available channels to use as 
input. 

Map the input channel to an output 
channel. 



RCP 2.X Users Guide 
May 2014 

Page 57 of 85 

 
 
Now the configuration is ready to compile and load onto the device. 

Once the selection is made… 

… A connection will appear between the 
channels. 
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Click “Compile” to check for errors. 
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The “Compile” button runs a series of checks on the mapping that was created prior to allowing the 
configuration to be loaded onto the device. 
 
Now the program is ready to send and load onto the device. 
 

If the mapping has no errors, you should see 
this popup. 
Click OK to continue. 
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Click “Send Program” to load the program on 
to the device. 
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At this point the mapping has been loaded onto the device, and it should be running the loaded mapping.  
  	

Click “Close” to continue. 
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7.3.2 Mapping an Incoming RF Message 

This section will show how to map an incoming radio message.  
 
Please refer to Table 10 in Section 7.2.2 when mapping the incoming RF messages. 
 
This example will map button 1 of a Flex VUE transmitter to an output configured as PWM open loop on 
an MHR receiver, but this can be mapped to any output type on any of the supported programmable 
devices. 
 
Start by creating a new project with an MHR device selected and allow the device configuration to be 
read. This is the same process explained in Section 5. Once the project is started, navigate to the 
Programming Tab across the bottom of the UI. 
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Select the RF Command tab. 
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Click “RF Cmd In” to add the 

channel to the workspace. 
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Now the incoming message command should be selected. Based on Table 11 in Section 7.2.2, button 1 
of the Flex VUE maps to a Motion command with function 10. That information allows the user to 
configure the channel accordingly. 
 

Motion Command added to workspace. 
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Select the corresponding function number 

from the list. 
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After selecting the function number from 

the list, the channel will reflect the 

selection. Now the data from this 

command can be used to drive another 

channel. 
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7.3.3 Using the Matrix Channel to Configure Relays 

This section will show how to use the Matrix Channel to configure relays.  
 
Please refer to Table 10 in Section 7.2.2 when mapping the incoming RF messages. 
 
This example will map button 1 of a Flex VUE transmitter to an output/relay on an inteleSmart2 Receiver. 
The matrix and Analog to Step channels are only available on the inteleSmart2 Receiver. 
 
Start by creating a new project with an inteleSmart2 device selected and allow the device configuration to 
be read. This is the same process explained in Section 5. Once the project is started, navigate to the 
Programming Tab across the bottom of the UI. 

Drag the channel to the middle of the 

work space. 
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Click “Matrix” to add the channel to the 

workspace. 
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The “Matrix” is added to the workspace. 
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Number of Speeds: Controls the number of columns 

displayed. 

Number of Relays: Controls the number of rows displayed. 

Input Mode: Controls how the relays are 

driven. 

The Input mode property controls the number 

of Speed Input properties available to edit. 
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Relay Labels property allows the user to change 

the text on the channel. 

Input Label properties allow the user to change 

the text corresponding with the inputs. 

Click Relay  to add a Relay Channel to the 

workspace. 



RCP 2.X Users Guide 
May 2014 

Page 73 of 85 

 

 
 

 

Select a relay to map the channel to. This list is 

comprised of main board. 

Choose the state of the Relay: Normally Open 

or Normally Closed. 
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Select Input, then select the connection point 

of the Matrix Channel that you want the relay 

to connect to. 

The connection is made once the connection 

point is selected. 
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Click to add Analog to Discrete channel to 

workspace. 

From the property grid of the Matrix channel 

select the conversion channel as the input for 

direction 1. 
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Select the Input to the channel.

Auto Speed Mode: Adds an additional 

speed/step to a transmitter that has a fixed 

number of speeds. 

Auto Speed Time: The amount of time the 

transmitter’s max speed is transmitted before 

increasing to the auto mode speed. 

The user can select the number of speed points 

the analog is broken into. This is the maximum 

number of speed points the Matrix Channel 

sees unless the auto mode feature is enabled. 

These are configurable points at which the 

speed point is generated. There is a 2% 

hysteresis built into each of the speed points. 

Click “RF Cmd In” to add an RF Channel to the 

workspace. 

Configure the channel using the RF messaging 

table. 
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Map the input of the Analog Conversion 

channel to the RF Cmd In. 
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7.3.4 Multi Input Mode using the Matrix Channel 

This section will show how to use the Matrix Channel in Multi-Input Mode 
 
Start by creating a new project with an inteleSmart2 device selected and allow the device configuration to 
be read. This is the same process explained in Section 5. Once the project is started, navigate to the 
Programming Tab across the bottom of the UI. From the I/O tab add a Matrix channel the workspace. 
 

 

Changing the input mode of the channel 

changes the Matrix channel display. This mode 

allows individual channels to drive each of the 

speed points defined. 

Changing the input mode enables the 

corresponding input properties. The number of 

enabled inputs is based on the number of 

speed points selected. 
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NOTE: Any values greater than zero will cause the relays mapped to the input to be driven high. 
 

The input channel mapped to the input for 

Multi‐input mode is configured using the drop 

down options. 
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7.3.5 CAN-2 Mapping 

The CAN-2 device is configured the same as the MHR and inteleSmart2 devices. The CAN-2 also 
requires special firmware to support the mapping capability of RCP. 
 

7.3.6 Additional Mapping Examples 

This section shows some commonly used mappings.  Refer to Section 7 for specifics on each of the 
various types of connections. 
 

 
 

Figure 34: Example of a digital input being mapped directly to an output. 

 

 
 

Figure 35: Example of a mathematical operation performed on inputs before directing to an 
output. 

 

 
 
Figure 36: Example of a J1939 Parameter Group message being constructed using a Constant and 

an RF Motion Command. 
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Figure 37: This example shows how the data from the RF command can be distributed through 
several channels. 

 

 

Figure 38: This example shows how to scale an 8-bit RF message to a 10-bit value to drive an 
output. NOTE: This is needed to achieve full scale on the output. 
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Figure 39: This example shows how to configure 12 relays using various input methods to drive 
the relays. 

 

7.3.7 RF Masking 

The CAN-2, MHR and inteleSmart2 receivers support RF masking. This feature allows the receiver to 
come online even if the RF command is active. This property is available on either RFCmd or RFDigBit 
channels. 
 
Only the XLTX/MLTX2/MBT/PGT transmitters send the data during the start sequence. 
 

 
Figure 40: The channels that support Check On Start 

 

 
Figure 41: Property to check or ignore during start sequence. 
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8 Channel and Frequencies 
Table 13: Channel Sets and Frequencies 

400 MHz Part 15  419 MHz  900 MHz Part15 
Channel Frequency  Channel Frequency  Channel Frequency 
01 433.000 MHz  01 410.300 MHz  01 903.30 MHz 
02 433.050 MHz  02 410.300 MHz  02 906.30 MHz 
03 433.100 MHz  03 419.200 MHz  03 907.80 MHz 
04 433.150 MHz  04 419.300 MHz  04 909.30 MHz 
05 433.200 MHz  05 419.300 MHz  05 912.30 MHz 
06 433.250 MHz  06 419.300 MHz  06 915.30 MHz 
07 433.300 MHz  07 419.800 MHz  07 919.80 MHz 
08 433.350 MHz  08 419.300 MHz  08 921.30 MHz 
09 433.400 MHz  09 419.300 MHz  09 902.30 MHz 
10 433.450 MHz  10 419.100 MHz  10 904.10 MHz 
11 433.500 MHz  11 419.300 MHz  11 904.30 MHz 
12 433.550 MHz  12 419.100 MHz  12 905.10 MHz 
13 433.600 MHz  13 419.500 MHz  13 905.50 MHz 
14 433.650 MHz  14 419.700 MHz  14 905.70 MHz 
15 433.700 MHz  15 419.600 MHz  15 906.60 MHz 
16 433.750 MHz  16 419.700 MHz  16 908.70 MHz 
17 433.800 MHz  17 419.900 MHz  17 908.90 MHz 
18 433.850 MHz  18 419.100 MHz  18 909.10 MHz 
19 433.900 MHz  19 419.100 MHz  19 910.10 MHz 
20 433.950 MHz  20 419.700 MHz  20 910.70 MHz 
21 434.000 MHz  21 419.000 MHz  21 911.00 MHz 
22 434.050 MHz  22 419.200 MHz  22 911.20 MHz 
23 434.100 MHz  23 419.000 MHz  23 912.00 MHz 
24 434.150 MHz  24 419.200 MHz  24 914.20 MHz 
25 434.200 MHz  25 419.400 MHz  25 914.40 MHz 
26 434.250 MHz  26 419.600 MHz  26 914.60 MHz 
27 434.300 MHz  27 419.800 MHz  27 914.80 MHz 
28 434.350 MHz  28 419.800 MHz  28 915.80 MHz 
29 434.400 MHz  29 419.400 MHz  29 917.40 MHz 
30 434.450 MHz  30 419.200 MHz  30 923.20 MHz 
31 434.500 MHz  31 419.300 MHz  31 927.00 MHz 
32 434.550 MHz  32 419.300 MHz  32 927.30 MHz 
 
2.4 GHZ: FHSS  
Channel sets are designated between 1 and 32. The frequency range is between 2402-2478 MHz. The 
frequency hopping protocol does not use one particular frequency to transmit a message. Messages are 
transmitted over multiple frequencies in a predefined sequence or channel set. In doing so, this protocol 
is able to compensate for interference that may be present on a single frequency by sending the message 
across multiple frequencies.  
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Appendix A.  
 
The CAN messages contain 8 bytes of data. The following table describes the data portion of the 
messages. 
 
 
PGN 65410 Number of Bits 
PGN 65410 8 
Battery Level 8 
RSSI 2 
Command Data Valid 2 
Horn Command 2 
Stop Command 2 
Start Command 16 
Project ID 20 
Transmission ID 4 
 
PGN 65411 Number of Bits 
Digital Bits 1-8 for Function 1 8 
Digital Bits 1-8 for Function 2 8 
Digital Bits 1-8 for Function 3 8 
Digital Bits 1-8 for Function 4 8 
Digital Bits 1-8 for Function 5 8 
Digital Bits 1-8 for Function 6 8 
Digital Bits 1-8 for Function 7 8 
Digital Bits 1-8 for Function 8 8 
 
PGN 65412 Number of Bits 
Digital Bits 1-8 for Function 9 8 
Digital Bits 1-8 for Function 10 8 
Digital Bits 1-8 for Function 11 8 
Digital Bits 1-8 for Function 12 8 
Digital Bits 1-8 for Function 13 8 
Digital Bits 1-8 for Function 14 8 
Digital Bits 1-8 for Function 15 8 
Digital Bits 1-8 for Function 16 8 
 
Data values for Motion and Analog data are clip at 250 for J1939 compliance.  
 
PGN 65413 Number of Bits
Motion Command Data 1 8 
Motion Command Data 2 8 
Motion Command Data 3 8 
Motion Command Data 4 8 
Motion Command Data 5 8 
Motion Command Data 6 8 
Motion Command Data 7 8 
Motion Command Data 8 8 
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PGN 65414 Number of Bits
Motion Command Data 9 8 
Motion Command Data 10 8 
Motion Command Data 11 8 
Motion Command Data 12 8 
Motion Command Data 13 8 
Motion Command Data 14 8 
Motion Command Data 15 8 
Motion Command Data 16 8 
 
PGN 65415 Number of Bits
Analog Command Data 1 8 
Analog Command Data 2 8 
Analog Command Data 3 8 
Analog Command Data 4 8 
Analog Command Data 5 8 
Analog Command Data 6 8 
Analog Command Data 7 8 
Analog Command Data 8 8 
 
PGN 65416 Number of Bits 
Analog Command Data 9 8 
Analog Command Data 10 8 
Analog Command Data 11 8 
Analog Command Data 12 8 
Analog Command Data 13 8 
Analog Command Data 14 8 
Analog Command Data 15 8 
Analog Command Data 16 8 
 


